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Figure 1: Displacement from natural disasters (blue) and conflict (orange) in 2020
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Figure 2: Is this true? Figure 3: Let’s look into this

Yuri M. Zhukov API-231 / GIS-PubPol / 19



Overview
Vignettes

Applications of Meteorological Data to the Study of Conflict
Varieties of Meteorological Data

Overview

Yuri M. Zhukov API-231 / GIS-PubPol / 19



Overview
Vignettes

Applications of Meteorological Data to the Study of Conflict
Varieties of Meteorological Data

What do we mean by “climate and weather”?
1. Long-term climate trends

a) changes in average surface temperature
b) changes in average precipitation
c) sea level rise
d) sea ice melt

2. Short-term weather “shocks”
a) unusually hot/cold weather
b) unusually dry/wet weather

3. DIscrete weather events
a) extreme weather (e.g. storms, tornadoes)
b) visibility obstructions (e.g. clouds, haze)
c) floods
d) droughts
e) tsunamis

Figure 4: The storm is coming?
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Varieties of Meteorological Data

Climate change as a driver of armed
conflict and violence

1. Direct links between temperature,
precipitation and political violence
(Kevane and Gray 2008, Hendrix and
Salehyan 2012, Levy and Sidel 2014,
Mares and Moffett 2016)

2. Indirect effects on violence, through
migration, resource competition,
food insecurity (Ash and Obradovich
2020, Jones et al. 2017)

3. Impacts on social unrest in specific
settings, like urban areas (Koren et
al. 2021, Koubi et al. 2021)

Figure 5: A cause of war?
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Short-term weather and violence
1. Cloud cover as instrumental variable

for drone strikes (Mahmood and
Jetter 2019, Saeed and Spagat 2021)

2. Weather shocks as instrumental
variable for famine (Rozenas and
Zhukov 2019)

3. Rainfall shocks as instrumental
variable for economic growth (Miguel
et al 2004, Miguel and Satyanath
2010, Sarsons 2015, Mellon 2023)

Figure 6: W is the instrumental variable
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What do we know?

Figure 7: There is a positive correlation between higher temperatures and violence
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At the macro level, civil conflict is more likely in hotter, drier times

Figure 8: Around the globe Figure 9: Conflict in tropics Figure 10: Civil wars in Africa
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Communal and inter-group conflict also more likely in climate-stressed times

Figure 11: In Kenya Figure 12: In East Africa Figure 13: In Brazil
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Similar correlations with other types of unrest across the globe

Figure 14: Regime change Figure 15: Riots in Africa Figure 16: Riots in India
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As well as for crime, sexual assault and other violence in the U.S.

Figure 17: Crime in U.S. Figure 18: Rape in U.S. Figure 19: Fights at stadiums
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Correlation ̸= causation
1. Emerging consensus that climate

change by itself does not “cause”
conflict (Hsiang and Burke 2014,
Van Uexkull and Buhaug 2021)

2. Effect is likely indirect, though
mechanisms like:

a) demographic changes (McAdam
2017, Dorward and Fox 2022,
Koubi et al 2021)

b) resource competition (Njiru 2012,
Harvey and Pilgrim 2011)

c) youth bulges (Barakat and Urdal
2009, Nordas and Davenport 2013)

d) migration (Adamson 2006,
Nagabatla et al 2021, Nordas 2014,
Menashe-Oren 2020)

e) state capacity (Koren and Sarbahi
2018)

Figure 20: Demographic time bomb?
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Applications of Meteorological Data to the Study of Conflict
Varieties of Meteorological Data

Historical weather & climate raster data (partial list)

Source/link Spatial resolution Frequency Availability Free? Global?

NOAA 0.5 × 0.5 degree Monthly 1900-2014 ✓ ✓
CRUTS 0.5 × 0.5 degree Monthly 1901-2022 ✓
ERA5 0.25 × 0.25 degree Hourly 1940-Present ✓ ✓
GLDAS 0.25 × 0.25 degree Hourly 1948-Present ✓ ✓
FLDAS 0.1 × 0.1 degree Monthly 1982-2016 ✓ ✓
TerraClimate 0.04 × 0.04 degree Monthly 1958-2023 ✓ ✓
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https://psl.noaa.gov/data/gridded/data.UDel_AirT_Precip.html
https://www.nature.com/articles/s41597-020-0453-3
https://cds.climate.copernicus.eu/cdsapp#!/dataset/reanalysis-era5-single-levels?tab=overview
https://disc.gsfc.nasa.gov/datasets/GLDAS_NOAH025_3H_2.1/summary?keywords=GLDAS
https://disc.gsfc.nasa.gov/datasets/FLDAS_NOAH01_C_GL_MC_001/summary?keywords=FLDAS
https://www.climatologylab.org/terraclimate.html
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Climate model future predictions (partial list)

Source/link Spatial resolution Free? Global?

CESM / CIME 0.5 × 0.5 degree ✓ ✓
GFDL-ESM 1 × 1 degree ✓ ✓
MPAS Voronoi mesh ✓ ✓
GISS Model E, E2R 1 × 1 degree ✓ ✓
E3SM v2 1 × 1 degree ✓ ✓
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https://www.cesm.ucar.edu/models/cesm2
https://www.gfdl.noaa.gov/earth-system-models/
https://geomodeling.njnu.edu.cn/modelItem/703356b1-7835-413a-9724-ee0e8b5fcf6c
https://geomodeling.njnu.edu.cn/modelItem/b677eb55-2f54-4a70-abd3-ca08f7e5eb07
https://e3sm.org/model/scientifically-validated-configurations/v2-configurations/
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Greenhouse gas emissions (partial list)

Source/link Spatial resolution Frequency Availability Free? Global?

EDGAR 0.1 × 0.1 degree Annual 1970-Present ✓ ✓
ESS-DIVE 1 × 1 degree Annual 1751-2013 ✓ ✓
Global Carbon Atlas City-level Annual 1960-Present ✓ ✓
EPA-FLIGHT Facility-level Annual 2010-Present ✓
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https://edgar.jrc.ec.europa.eu/
https://data.ess-dive.lbl.gov/view/doi:10.3334/CDIAC/FFE.NDP058.2016
https://globalcarbonatlas.org/emissions/city-emissions/
https://ghgdata.epa.gov/ghgp/main.do
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Extreme weather events (partial list)

Source/link Spatial resolution Availability Free? Global?

NOAA Storm Events Points 1950-2023 ✓
EM-DAT Points, admin units 1988-Present ✓ ✓
GDIS Points (centroids) 1960-2018 ✓ ✓
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https://www.ncdc.noaa.gov/stormevents/ftp.jsp
https://doc.emdat.be/
https://sedac.ciesin.columbia.edu/data/set/pend-gdis-1960-2018/data-download
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Words of caution
1. Existing research conceptualizes

climate change and conflicts in
diverse ways (Meierding 2013,
Raleigh and Urdal 2007, Sharifi et al
2021, Van Uexkull and Buhaug 2021)

2. Complexity of causal pathways,
patchy data, disagreement over
measurement, analytical approaches
(Adams et al 2018, Sakaguchi et al
2017, Sheffran et al 2012)

3. Differences in assumptions, data &
methods lead to vastly different
conclusions (Hsiang and Burke 2014,
Buhaug et al 2014, Van Uexkull and
Buhaug 2021)

Figure 21: The answer is “it depends”
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Overview of lab exercise

1. Changes in summer temperatures by country
2. Drought severity and violence during the 2011 Arab spring
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

We will compare average monthly high temperatures in July 2023 to July 1958

Figure 22: Vignette 1 / Step 1
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And calculate a new raster that shows where the changes were lowest/highest

Figure 23: Vignette 1 / Step 2
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Changes in summer temperatures by country
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We will then aggregate these changes by country, to see who was most affected

Figure 24: Vignette 1 / Step 3

Yuri M. Zhukov API-231 / GIS-PubPol / 19



Overview
Vignettes

Changes in summer temperatures by country
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We will then calculate yearly averages of severe drought indices

Figure 25: Vignette 2 / Step 1
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We will extract drought indices for the Middle East and North Africa

Figure 26: Vignette 2 / Step 2
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And will see if countries more affected by drought saw more violence in 2011

Figure 27: Vignette 2 / Step 3
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We can obtain monthly mean high temperature data from
climatologylab.org/terraclimate.html
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https://www.climatologylab.org/terraclimate.html
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There are several types of data here. See the “guide for dataset abbreviations”
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We want tmax (mean high temperatures) and PDSI (drought index)
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Let’s download the “Individual years” data
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Changes in summer temperatures by country
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The file naming convention is TerraClimate_[variable]_[year].nc. Go to
TerraClimate_tmax_2023.nc
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Download this file through the HTTPServer link
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Do the same for the 1958 temperature data TerraClimate_tmax_1958.nc
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And the 2010 drought index data TerraClimate_PDSI_2010.nc
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We will use global country-level boundaries data from naturalearthdata.com

Yuri M. Zhukov API-231 / GIS-PubPol / 19

https://www.naturalearthdata.com/downloads/
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Changes in summer temperatures by country
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We want the “Small scale data, 1:100m”. Click on the Cultural link
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Drought severity and violence during the 2011 Arab spring

Click on the “Download countries” link under “Admin 0 - Countries” to get the zip
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We will be using the same event data on violence as in the last two labs:
UCDP GED version 23.1, in csv format
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https://ucdp.uu.se/downloads/index.html#ged_global
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Here is the full list of data sources and links:

Category Type Format Data source

Average monthly max temperature Raster .nc TerraClimate
Palmer Drought Severity Index Raster .nc TerraClimate
Country borders Vector (polygons) .shp Natural Earth
Political violence Table (non-geo) .csv UCDP GED

These are all in the WT03.zip file posted on Canvas.

Yuri M. Zhukov API-231 / GIS-PubPol / 19

https://www.climatologylab.org/terraclimate.html
https://www.climatologylab.org/terraclimate.html
https://www.naturalearthdata.com/downloads/110m-cultural-vectors/
https://ucdp.uu.se/downloads/index.html#ged_global
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Changes in summer temperatures by country
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Changes in summer temperatures by country
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Always save your progress!
Go to Project → Save As...
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Changes in summer temperatures by country
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Vignette 1. Load the 2023 temperature data (Layer → Add Layer → Add
Raster Layer). TerraClimate_tmax_2023.nc file in Data/TerraClimate
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This is a multi-band raster. Let’s open up the layer Properties to see what these
bands represent
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Go to the Information tab and scroll down to Bands. There are 12 bands,
corresponding to months of the year (e.g. 1 = January, 12 = December)
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Let’s display temperatures for July. In Symbology, change Render type to
Singleband pseudocolor and set Band to Band 07.... Adjust the other
graphical parameters to taste.
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Places closer to the equator are hotter. Antarctica is very cold
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Let’s also load the tmax raster data for 1958
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Once both rasters are loaded, open the Raster Calculator...
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Set the Expression to
"TerraClimate_tmax_2023@7"-"TerraClimate_tmax_1958@7" (July temp in
2023 minus July temp in 1958). Save the output as tmax_diff.tif
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This will take a few minutes to compute
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Changes in summer temperatures by country
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The tmax_diff raster should look something like this
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Let’s examine the distribution of global temperature changes. In the layer
Properties for tmax_diff, open the Histogram tab. Click Compute Histogram
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Most temperature changes were positive, with a mode around + 2 degrees Celsius
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Let’s calculate average changes by country. Load the
ne_110m_admin_0_countries.shp file
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Once the borders are loaded, open Zonal Statistics from the Processing
Toolbox. Set Input layer = ne_110m_admin_0_countries, Raster layer =
tmax_diff, prefix = tmax_diff_, Statistics to calculate = Mean. Save the
output as tmax_diff.geojson

Yuri M. Zhukov API-231 / GIS-PubPol / 19



Overview
Vignettes

Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

North Africa and Central Asia appear to have had the most acute increases in July
temperatures
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Drought severity and violence during the 2011 Arab spring

Clicking on the Σ button ("Show Statistical Summary"), we can look up some
descriptive stats. The average country saw an increase of 1.77 degrees Celsius
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Let’s create an interactive histogram with Plotly. Set Plot type = Histogram,
Layer = tmax_diff, Grouping field = tmaxdiff_mean. Click Create Plot
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Clicking on the individual bars of the histogram will highlight the countries that fall
into that bin, such as here for increases between 4 and 5 degrees
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. . . increases of 3-4 degrees
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. . . increases of 2-3 degrees
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. . . increases of 1-2 degrees (the most numerous category)
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. . . increases between 0 and 1 degree
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. . . decreases of 0 to 1 degree
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. . . decreases of 1 to 2 degrees
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. . . and decreases of 2 to 3 degrees (just Uruguay here)
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Drought severity and violence during the 2011 Arab spring

Yuri M. Zhukov API-231 / GIS-PubPol / 19



Overview
Vignettes

Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Vignette 2! Let’s create a regional subset of countries. The ne_110m... file has a
variable called REGION_WB, where one of the categories is “Middle East & North
Africa”
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Go to Select by Expression, set Expression to REGION_WB='Middle East &
North Africa', and click Select Features
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Export the selected features to a new file
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Save the layer as mena.geojson. Make sure the box is checked next to ✓“Save
only selected features”
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A new layer with 20 countries should appear in your project window
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Load the drought index raster TerraClimate_PDSI_2010.nc
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Another multiband raster. Open up the layer Properties to see the bands
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As before, there are 12 bands here, one for each month
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Let’s calculate the average annual drought index, over all months.
Open the Raster Calculator and set Expression to
("TerraClimate_PDSI_2010@1"+"TerraClimate_PDSI_2010@2"+
"TerraClimate_PDSI_2010@3"+"TerraClimate_PDSI_2010@4"+
"TerraClimate_PDSI_2010@5"+"TerraClimate_PDSI_2010@6"+
"TerraClimate_PDSI_2010@7"+"TerraClimate_PDSI_2010@8"+
"TerraClimate_PDSI_2010@9"+"TerraClimate_PDSI_2010@10"+
"TerraClimate_PDSI_2010@11"+"TerraClimate_PDSI_2010@12")/12
(you may want to copy and paste this one). Save the raster as
pdsi_2010_mean.tif
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This will take a few minutes to process
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Changes in summer temperatures by country
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The output will look something like this: a single-band raster of averages

Yuri M. Zhukov API-231 / GIS-PubPol / 19



Overview
Vignettes

Changes in summer temperatures by country
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Calculate country averages. Open Zonal Statistics, set Input layer = mena,
Raster layer = pdsi_2010_mean, prefix = pdsi2010_, Statistics to
calculate = Mean. Save the output as mena_pdsi.geojson
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Changes in summer temperatures by country
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Try visualizing the country-level results. Lower index scores = worse drought
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

The drought index is negative virtually everywhere except Western Sahara
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Finally, let’s link this up with data on violent events. Load GEDEvent_v23_1.csv,
with spatial index
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Select by Expression: year=2011. Click Select Features
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Open the Count Points in Polygon tool. Select Polygons = mena_pdsi,
Points = GEDEvent_v23_1. Make sure the box is checked next to Selected
Features Only for the points. Name the count field events2011, and save the
output file as mena_pdsi_ged.geojson. Click Run
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Changes in summer temperatures by country
Drought severity and violence during the 2011 Arab spring

Open the Plotly tool. Set Plot type = Scatter Plot, Layer = mena_pdsi_ged,
X field = pdsi2010_mean, Y field = events2011. Click Create Plot
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From the scatterplot, we can see that the highest levels of violence happened in
countries with negative PDSI scores (more drought)
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If we click on some of the points in the upper-left corner, we can see countries like
Syria, which experienced severe drought in 2010 and high violence in 2011
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. . . or Iraq
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. . . or Yemen
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We can adjust some of the graphical parameters to make the scatterplot more
readable, like adding country labels and putting the violence variable on a
logarithmic scale
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Looks better now
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You can also perform all these steps in R
(see replication code wt03_demo.R in WT03.zip)

Figure 28: Vignette 1 Figure 29: Vignette 2
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Hot Tip: Scripting in Python QGIS
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Tired on pointing and clicking? In almost every geoprocessing command, there is
a menu called Advanced, with an option to Copy as Python Command
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Paste it into a text file to see the code. The directory structure
(/home/username/*) will depend on where you saved the WT03 files
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You can use these code snippets to assemble a Python script with all the commands
we used today (see Code/wt03_demo.py script in the WT04.zip file)
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In QGIS, you can run this script through a Python console. Go to Plugins menu →
Python Console
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Copy a command into the console and click “Enter” (here we are re-calculating the
temperature difference raster from Vignette 1)
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When QGIS finishes processing, the console will print a line that starts with
'OUTPUT':..., telling you where the output file has been saved (note that this will
not load the output automatically)
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We can repeat this with the next line in the code (Zonal Statistics for temperature
changes by country)
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When we open up the Python-generated file, and re-create the histogram, we see
that the results are identical to the one we created earlier. Scripting can be very
handy if you are doing batch processing with repetitive, easily-automated tasks
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